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ABSTRACT

A Tool to Analyze Environmental Impacts of Roads on Forest Watersheds

by

Ajay Prasad, Master of Science

Utah State University, 2006

Major Professor: Dr. David G. Tarboton

Department: Civil and Environmental Engineering

The construction and use of forest roads can have impacts on geomorphic
processes and erosion patterns in forested basins. Analyzing these impacts will help
forest managers to effectively manage road and road drainage system and hence
minimize the negative impacts of forest roads. To manage forest roads effectively the
USDA Forest Service (USFS) has developed a road inventory from Global
Positioning System (GPS) road surveys. The primary goal of the inventory is to
document the condition of the roads, sources of sediment, and how sediments that
originate from the road prism are ultimately routed to the hillslope and stream
network. The Forest service road inventory is stored in Geographic Information
System (GIS) shapefiles following a data structure that has been developed for this
purpose. In this project a GIS tool was developed to use the road inventory

information to analyze the effects of forest roads on forest basins. This tool is based



i
on a formal database schema (database model) for the representation of forest road
and road drainage information. A pre-processing tool was developed to ingest
information from the USFS road inventory into the database, performing quality
control and consistency checks. The functionality of the GIS tool is divided into
three modules. The first module calculates the sediment production for each road
segment from slope, length, road surface condition and road-side drain vegetation
information in the road inventory. In this calculation slope is derived by overlaying
the road path on a Digital Elevation Model (DEM). Sediment production is
accumulated to drain points by adding the sediment production from contributing
road segments. These drain point sediment loadings are then used in a DEM
weighted flow accumulation function to calculate sediment load inputs to streams.
The second module analyzes the impact of forest roads on terrain stability. Terrain
stability is assessed by calculating the specific discharge due to road drainage and
using this, together with slope, as inputs to an infinite plane slope stability model.
The final module analyzes the contiguity and fragmentation of stream network fish
habitat using road inventory information on the potential blockage of fish passage at
stream crossings. The model was compared with the methods followed by the USFS
to identify potential impact of forest roads on watershed and it was found that while
at an aggregate level the calculations from the USFS procedures and the new
approach were comparible, the detailed information in the road inventory allowed
more specific association of road segments producing sediment with streams to which
they were connected, providing for better calculations of stream sediment inputs.

Comparison of indicators of the potential for gully formation from USFS procedures



with surveyed drain points where gullies were observed found that stream proximity
and hillslope position were not good indicators of potential gully formation. This is
believed to be due to geomorphological differences between regions where these
indicators were developed, and the study are used in this project. Terrain slope and
an erosion sensitivity index that combines slope with the length of road draining to a
drain point were found to be good predictors of gully formation, with the erosion
sensitivity index that relied on additional information from the road inventory survey
having a greater capability for discriminating drain points with a high potential for
gully formation. This information derived from the road inventory provides useful
information for forest road managers to inform the prioritization of road maintenance

and drainage improvement planning.

(203 pages)
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the formation of gullies and landslides along the road would be helpful for further

evaluation of model predictions where it is useful to be able to visually check the

appearance of the site.
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APPENDIX 1

USFS ROAD INVENTORY TABLES DATA DICTIONARY

Roads Shapefile Attribute Table
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Field Name Description
IDRAINNUM Main road drainage feature
2DRAINNUM Secondary road drainage feature
SURF TYPE Road surface type
SURF COV Road surface cover
SURF COND Road surface condition
RD EDGE 1 Cut slope height or road edge feature
RD EDGE 2 Cut slope height 2 or road edge feature
EDGE VEG 1 Road side vegetation density
EDGE VEG 2 Secondary road side vegetation density
EDGE CND 1 Primary cut or fill slope condition
EDGE CND 2 Secondary cut or fill slope condition
FLOW PATHI1 Location of flowing water
FLOW PATH2 Location of flowing water
FLWPTH VGl Vegetation on flow path 1
FLWPTH VG2 Vegetation on flow path 2
FLWPTHCNDI Condition of flow path 1
FLWPTHCND?2 Condition of flow path 2
FILL CHAN Distance. Fill slope toe to channel edge in feet
Date Collection date
Vehicle Vehicle number used for survey




Ditch Relief Drain Point Shapefile Attribute Table

Field Name Description
DRAINNUM Main road drainage feature number
Size Pipe diameter in inches
Pipe Len. (ft.) Pipe length
Type Pipe material
Condit Percent sediment occlusion
Slope Shap Shape of the slope. Eg: concave
Dischrg to Destination of discharge
Stream Con Stream connection
Fill Eros Is fill slope eroded below pipe
Flow Diver Flow diversion present or not
Obstruct Debris in flow path of drain
Flow diffuser Flow diffuser type
Date Collection date
Vehicle Collection vehicle identifier
Comment Additional comments

Stream Crossing Drain Point Shapefile Attribute Table

Field Name Description
DRAINNUM Main road drainage feature identifier
Type Culvert type
R Pipe Dia. Round pipe diameter
Oval Pipe Oval pipe dimension
Pipe Len. Pipe length
Chan. wdth Channel width
Pipe Num Number of pipe present
Fill Depth Units of feet
Condit Culvert condition
Chan Angl Angle between pipe and channel
Block Typ Evidence of blockage
Outlet drp Measured below pipe in feet and tenths
Pl depth Depth below outfall in feet and tenths
Pipe grade Measured in %
Substrate Crossing substrate
Debris Flw Debris flow present or not
Fill Erosn Flow present erosion present or not
Diversion Diversion potential
Date Collection date
Vehicle Collection vehicle identifier

Comment

Additional comments




Lead-off Drain Point Shapefile Attribute Table
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Field Name Description
DRAINNUM Main road drainage feature identifier
Slope Shap Slope shape
Dischrg to Destination of discharge
Stream Con Stream connection present or not
Condit Condition
Obstruct Debris in flow path of drain
Date Collection date
Vehicle Collection vehicle identifier
Comment

Water Bar Drain Point Shapefile Attribute Table

Field Name Description
DRAINNUM Main road drainage feature identifier
Slope Shap Slope shape
Dischrg to Destination of discharge
Stream Con Stream Connection present or not
Obstruct Debris in flow path of drain
Fill Eros Fill erosion present or not
Type Drain point material
Condit Condition
Date Collection date
Vehicle Collection vehicle identifier
Comment

Broad Based Dip Drain Point Shapefile Attribute Table

Field Name Description
DRAINNUM Main road drainage feature identifier
Slope Shap Shape of the slope
Dischrg to Destination of discharge
Stream Con Stream connection
Obstruct Debris in flow path of drain
Fill Eros Fill erosion present or not
Type
Condit Condition of the drain point
Material
Date Collection date
Vehicle Collection vehicle identifier

Comment




Non-Engineered Drain Point Shapefile Attribute Table
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Field Name Description

DRAINNUM Main road drainage feature identifier
Slope Shap Slope shape

Dischrg to Destination of discharge

Stream Con Stream connection present or not
Obstruct Debris in flow path of drain

Fill Eros Fill erosion present or not
Condit Condition

Date Collection date

Vehicle Collection vehicle identifier
Comment

Sump Drain Point Shapefile Attribute Table

Field Name Description

DRAINNUM Main road drainage feature identifier
Condit Condition

Date Collection date

Vehicle Collection vehicle identifier
Comment

Diffuse Drain Point Shapefile Attribute Table

Field Name Description

DRAINNUM Main road drainage feature identifier
Slope Shap Slope shape

Dischrg To Destination of discharge

Stream Con Stream connection present or not
Obstruct Debris in flow path of drain

Fill eros Fill erosion present or not

Date Collection date

Vehicle Collection Vehicle identifier

Comment




GRAIP DATABASE TABLES

Master Tables

DrainPoints Table
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APPENDIX 2

Field Name Description

GRAIPDID Unique Drain Point identifier

DrainTypelD Unique Drain Point type identifier

CDate Survey date

CTime Survey time

VehiclelD Survey vehicle Identifier

DrainlD Drain ID from Road inventory Drain points file

StreamConnectID Attribute representing stream connection present or not

Comments Description or comments about the Drain Point feature

SedProd Accumulated Road Sediment load to each drain point
(kg/yr)

ELength Effective length of the road draining to each drain point
(m)

UnitSed Drain point unit sediment load (kg/m/yr)

SedDel Sediment load delivered to streams

SI SINMAP Stability Index values at each drain point

Slope Slope at each drain point

ESI Erosion Sensitivity Index (m) values at each drain point

PipeDiaToChanWidthScore

Hazard Score calculated from Ratio of Culvert pipe
diameter to channel width

SkewAngleScore Hazard Score calculated from Channel Skew angle

SBI Stream blocking index indicating culvert plugging
susceptibility

Barrier Flag representing the drain point is a fish passage barrier
or not

RoadLines Table
Field Name Description

GRAIPRID Unique Road line segment Identifier

CDate Survey date

CTime Survey time

VehiclelD Survey vehicle identifier

RoadNetworkID Identifier for a road network. Base erosion rate depends on
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road network ID

RoadTypelD Identifier for type of the road (eg: system road, trail)

GRAIPDIDI Identifier of drain point that drains side one of the road

GRAIPDID2 Identifier of drain point that drains side two of the road

SurfaceTypelD Identifier representing road surface type.

SurfaceConditionID Identifier representing road surface condition

SurfaceCoverlD Identifier representing the road surface cover

RoadEdgelID Identifier for road side one edge information

RoadEdge2ID Identifier for road side two edge information

EdgeVegetation1ID Identifier for road side one edge vegetation

EdgeVegetation2ID Identifier for road side two edge vegetation

FlowPath11D Identifier for road side one flow path information

FlowPath2ID Identifier for road side two flow path information

FlowPathVeglID Identifier for road side one flow path vegetation

FlowPathVeg2ID Identifier for road side two flow path vegetation

FlowPathCond1ID Identifier for road side one flow path condition

FlowPathCond2ID Identifier for road side two flow path condition

FillChannellD Identifier giving road fill channel information

Comments Additional Comments about the road segment

StreamConnect11D Identifier for road side one stream connectivity status

StreanConnect21D Identifier for road side two stream connectivity status

Length Length of the road segment (m)

SedProd1 Sediment production from side one of the road (kg/yr)

SedProd2 Sediment production from side two of the road (kg/yr)

UnitSed Unit sediment production from both sides of the road
segment (kg/m/yr)

TotSedProd Total sediment production from both sides of the road
(kg/yr)

TotSedDel Total sediment delivered to streams (kg/yr)

UnitTotSedDel Total unit sediment delivered to streams (kg/m/yr)

BroadBaseDipAtt Table
Field Name Description

GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table

BroadBaseDipTypelD Identifier representing Broad Base Dip type

SlopeShapelD Identifier for drain point discharge slope shape

DischargelD Identifier for drain point discharge feature (e.g. gully,
forest floor)

ObstructionID Identifier for the presence of an obstruction

FillErosionID Identifier for presence of fill erosion

BroadBaseDipConditionID

Identifier for broad base dip drain point condition
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| MateriallD | Identifier for material found in the drain point
DiffuseDrainAtt Table
Field Name Description
GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table
SlopeShapelD Identifier for drain point discharge slope shape
DischargeTolD Identifier for drain point discharge feature (e.g. gully,
forest floor)
Obstruction]D Identifier for the presence of an obstruction
FillErosionID Identifier for presence of fill erosion
DitchReliefAtt Table
Field Name Description
GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table
SizelD Identifier for the size of the drain point
PipeLength Length of the culvert pipe used
DitchReliefTypelD Identifier for ditch relief type
SlopeShapelD Identifier for drain point discharge slope shape
DischargeTolD Identifier for drain point discharge feature (e.g. gully,
forest floor)
FillErosionID Identifier for presence of fill erosion
ObstructionID Identifier for the presence of an obstruction
FlowDiversionlD Identifier for the presence of flow diversion
FlowDiffuserID Identifier for flow diffuser type
LeadOffAtt Table
Field Name Description
GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table
SlopeShapelD Identifier for drain point discharge slope shape
DischargeTolD Identifier for drain point discharge feature (e.g. gully,
forest floor)
LeadOffConditionID Identifier for condition of lead off drain point
ObstructionID Identifier for the presence of an obstruction
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NonEngAtt Table
Field Name Description

GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table

NonEngConditionID Identifier for condition of Non-Engineered drain point

SlopeShapelD Identifier for drain point discharge slope shape

DischargeTolD Identifier for drain point discharge feature (e.g. gully,
forest floor)

Obstruction]D Identifier for the presence of an obstruction

FillErosionID Identifier for presence of fill erosion

StrXingAtt Table
Field Name Description

GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table

StrXingTypelD Identifier for stream crossing type

PipeDimID Identifier for culvert pipe dimension

PipeLength Culvert pipe length (feet)

ChannelWidth Channel width (feet)

PipeNumberID Identifier for number of pipes used

FillDepth Fill depth (feet)

StrXingConditionID Identifier for condition of stream crossing drain point

FillErosionID Identifier for presence of fill erosion

ChannelAngleID Identifier for angle between stream and stream crossing

BlockTypelD Identifier for the presence and type of stream crossing
blockage

OutletDrop Outlet channel drop (feet)

PoolDepth Channel pool depth (feet)

PipeGradient Stream crossing pipe gradient in percentage

SubstratelD Identifier for substrate material

DebrisFlowID Identifier for the presence of a debris flow

DiversionID Identifier for the presence and direction of channel

diversion

SumpAtt Table
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Field Name Description
GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table
SumpConditionID Identifier for condition of sump drain point
WaterBarAtt Table
Field Name Description

GRAIPDID Drain Point identifier. Foreign key to GRAIPDID in
DrainPoints Table

WaterBarTypelD Identifier for water bar type

SlopeShapelD Identifier for drain point discharge slope shape

DischargeTolD Identifier for drain point discharge feature (e.g. gully, forest
floor)

Obstruction]D Identifier for presence of obstruction

FillErosionID Identifier for presence of fill erosion

WaterBarConditionID | Identifier for condition of water bar crossing drain point
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Preferred Value Tables

BlockTypeDefinitions

BlockTypelD | BlockType Description

1 No Stream crossing not blocked (default)

2 Sediment Plume Stream crossing blocked by sediment plume

3 Scoured road Stream crossing blocked due to scoured road

4 Washed out road | Stream crossing blocked due to washed out road
5 Organic debris pile | Stream crossing blocked by organic debris pile

BroadBaseDipCondDefinitions

BroadBaseDipConditionID | Condition Description
1 No Problem Default

2 Puddles on road

3 Wetland in ditch

4 Saturated fill

BroadBaseDipTypeDefinitions

BroadBaseDipTypelD | BroadBaseDipTypeName | Description
1 Grade Reversal Default

2 Flat Ditch

3 Constructed

ChannelAngleDefinitions

ChannelAngleID | ChannelAngle | Description

1 <25 degrees The flow changes direction by less than 25 degrees
when entering stream crossing (Default)

2 <45 degrees The flow changes direction by less than 45 degrees
when entering stream crossing

3 45-75 degrees | The flow changes direction by between than 45 and
75 degrees when entering stream crossing

DebrisFlowDefinitions

DebrisFlowID | DebrisFlow | Description

1 No Default

2 Yes




DischargeToDefinitions

DischargeTolD | DischargeTo | Description
1 Forest Floor | Default

2 Gully

3 Ditch

4 Landslide

5 Wetland

6 Stream

DitchReliefCondDefinitions
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DitchReliefConditionID | Condition Description

1 0 Ditch relief drain in good condition

2 1-20% Ditch relief drain 1-20% blocked

3 20-80% Ditch relief drain 20-80% blocked

4 80-100% Ditch relief drain 80-100% blocked

5 Partially Crushed Ditch relief drain partially crushed

6 Totally Crushed Ditch relief drain totally crushed

7 Rusted Significantly | Ditch relief drain significantly rusted

8 Flows around pipe | Ditch relief drain flows around the pipe

DitchReliefTypeDefinitions

DitchReliefTypelD | DitchReliefTypeName | Description

1

CMP (Steel) Default

CON (Concrete)

ALM (Aluminum)

ABS (Plastic)

DN AW

WDN (LOG)

DiversionDefinitions

DiversionlD

Diversion | Description

1

None Default

2

1 Direction

3

2 Direction

DrainTypeDefinitions

DrainTypelD

DrainTypeName | TableName

Description

1

Broad base dip | BroadBaseDipAtt | Attribute table name for Broad
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Base Dip type drain point

2 Diffuse drain DiffuseDrainAtt | Attribute table name for Diffused
type drain point

3 Ditch relief DitchReliefAtt Attribute table name for Ditch
Relief type drain point

4 Lead off LeadOffAtt Attribute table name for Lead Off
type drain point

5 Non-engineered | NonEngAtt Attribute table name for Non-
Engineered type drain point

6 Stream Crossing | StrXingAtt Attribute table name for Stream
Crossings type drain point

7 Sump SumpAtt Attribute table name for Sump
type drain point

8 Water bar WaterBarAtt Attribute table name for Waterbar
type drain point

FillErosionDefinitions

FillErosionID | FillErosion | Description

1 No Default

2 Yes

FlowDiffuserDefinitions

FlowDiffuserID | FlowDiffuser Description

1 None Default

2 Half pipe fabric

3 Fabric hose

4 Rip rap

FlowDiversionDefinitions

FlowDiversionID | FlowDiversion | Description

0 Unknown

1 No

2 Yes

LeadOffCondDefinitions

LeadOffConditionID | Condition Description

1 No problem Default

2 Gullied




3 Not functional

4 Excess deposition
MaterialDefinitions

MateriallD | MaterialName | Description

1 Crushed

2 Native soil Default

3 Vegetated

4 Paved

5 Cinder

NonEngCondDefinitions

NonEngConditionID | Condition Description
1 Blocked Default
2 Diverted wheel track

3 Broken berm

4 Gully

5 Crosses road

6 Out sloped

ObstructionDefinitions

ObstructionID | Obstruction | Description

1 None Drain point not obstructed

2 Moderate | Drain point has moderate obstruction (Default)
3 Abundant | Drain point has considerable obstruction
PipeDimDefinitions

PipeDimID | Dimension | Description

0 N/A Default

1 12 Round 12 inch pipe

2 15 Round 15 inch pipe

3 18 Round 18 inch pipe

4 24 Round 24 inch pipe

5 36 Round 36 inch pipe

6 48 Round 48 inch pipe

7 60 Round 60 inch pipe

8 >60 Pipe greater than 60 inches diameter

9 13X17 Oval pipe 13 inches x 17 inches
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10 15X21 Oval pipe 15 inches x 21 inches
11 20X28 Oval pipe 20 inches x 28 inches
12 24X35 Oval pipe 24 inches x 35 inches
13 29X42 Oval pipe 29 inches x 42 inches
14 33X49 Oval pipe 33 inches x 49 inches
15 38X57 Oval pipe 38 inches x 57 inches

PipeNumberDefinitions

PipeNumberID | PipeNumber | Description

0 N/A Default

1 1

2 2

3 3

4 >3

SizeDefinitions

SizeID | DSize | Description

1 <12" | Pipe size less than 12 inches
2 12" 12 inch pipe

3 15" 15 inch pipe

4 18" 18 inch pipe (Default)

5 24" 24 inch pipe

6 >24" | Pipe size greater than 24 inches

SlopeShapeDefinitions

SlopeShapelD | SlopeShape | Description
1 Concave

2 Planar

3 Convex

StreamConnectDefinitions
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StreamConnectID | StreamConnection | Description

0 Unknown

1 No Drain point discharge does not enter stream
directly. (Default)

2 Yes Drain point discharge enters stream directly




StrXingCondDefinitions

StrXingConditionID

Condition

Description

Open and Sound

Default

Partially blocked

Totally blocked

Partially crushed

Totally crushed

Rusted significantly

Flows around pipe

R NN | B WN—

Scoured under bridge

StrXingTypeDefinitions

StrXingTypelD | StrXingTypeName Description
1 Steel culvert round Default
2 Steel culvert oval

3 Steel arch bottomless

4 Plastic culvert

5 Baffled culvert

6 Concrete culvert

7 Log culvert

8 Concrete ford

9 Natural ford

10 Aluminum culvert

11 Bridge

SubstrateDefinitions

SubstratelD | Substrate Description

1 Culvert Material | Default

2 Sand

3 Gravel

4 Boulders

5 Bedrock

6 Baffled

7 Concrete

SumpCondDefinitions

SumpConditionID | Condition Description
1 No problem Default

2 Fill saturation
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|3

| Puddles on road |

WaterBarCondDefinitions

WaterBarConditionID | Condition Description

1 No problem Default

2 Damaged

3 Too small

4 Drains inboard ditch

5 Wheel track damage

WaterBarTypeDefinitions

WaterBarTypelD | WaterBarTypeName | Description

1 Road material Default

2 Fabricated material

EdgeConditionDefinitions

EdgeConditionID | EdgeCondition Description

1 No problem Default

2 Badly rilled

3 Badly ravelling

4 Badly slumping

5 Bedrock

EdgeVegetationDefinitions

EdgeVegetationID | EdgeVegetation | Description

1 Default Road side vegetation density is unknown or not
specified

2 >75% Road side vegetation density is greater than 75%

3 >50% Road side vegetation density is greater than 50%

4 >25% Road side vegetation density is greater than 25%

5 >10% Road side vegetation density is greater than 10%

6 0% Road side vegetation density is less than 10%

FillChannelDefinitions

FillChannelID | FillChannel Description

1 0,[1] Fill slope ends right at channel

2 1-20,[20] Distance from fill slope toe to channel is between 1 and
20 feet

3 21-50,[50] Distance from fill slope toe to channel is between 21
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and 50 feet
4 Above Distance from fill slope toe to channel is greater than
50,[100] 50 feet (Default)
FlowPathCondDefinitions
FlowPathCondID | FlowPathCond | Description
1 No problem Default
2 Gullied
3 Buried
4 Rutted
5 Blocked
6 Stream course
7 Woody veg (%)
FlowPathDefinitions
FlowPathID | FlowPath Description
1 Ditch Default
2 Wheel tracks
3 Base of cut
4 Berm
5 Diffuse

FlowPathVegDefinitions

FlowPathVegID | FlowPathVeg | Description Multiplier

1 110% Unknown or unspecified road side flow 1
path vegetation density (Default)

2 >75% Road side flow path vegetated more than | 0.14
75%

3 >50% Road side flow path vegetated 50% to 0.14
75%

4 >25% Road side flow path vegetated 25% to 0.14
50%

5 >10% Road side flow path vegetated 10% to 1
25%

6 >0% Road side flow path vegetated 0 to 10% 1

7 0% No road side flow path vegetation 1
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RoadEdgeDefinitions

RoadEdgelD | RoadEdge | Description

1 Fill Road side feature is fill

2 0' no ditch | Road side level with terrain, no ditch

3 0-6' Road side cut between 0 and 6 ft high (Default)
4 6-18' Road side cut 6 to 18 ft high

5 >18',0% | Road side cut higher than 18 ft

RoadNetworkDefinitions

RoadNetworkID | RoadNetwork | Description BaseRate

1 Default Default Base rate from Luce and Black, 79
1999

2 Custom Custom base rate for a specific study area | 79

RoadTypeDefinitions

RoadTypelD | RoadType Description

1 Default Default

2 System road

3 High clearance road

SurfaceConditionDefinitions

SurfaceConditionID | SurfaceCondition | Description

1 Good

2 Rilled/eroded

3 Washboard

4 Rutted

5 Rocky

SurfaceCoverDefinitions

SurfaceCoverID | SurfaceCover | Description

| >75% Road surface is vegetated more than 75% (Default)

2 >50% Road surface is vegetated between 50 and 75%

3 >25% Road surface is vegetated between 25 and 50%

4 >10% Road surface is vegetated between 10 and 25%

5 0% Road surface is vegetated between 0 and 10%




SurfaceTypeDefinitions

SurfaceTypelD | SurfaceType Description | Multiplier

1 Default Default 1

2 Crushed rock 1

3 Native 5

4 Paved 0.2

5 Herbaceous Veg 1

6 Brush 1

7 Trees >4 in Dia 1

8 Cinder 1
VehicleDefinitions

VehicleID | Vehicle Description

1 Survey Truck

Utility Tables

FieldMatches

ID | AttTableID @ DBField DBFField

1 1 Cdate Date

2 1 Ctime Time

3 1 VehicleID Vehicle

4 1 DrainlD DRAIN ID

5 1 StreamConnectID STREAM CON
6 1 Comments COMMENT

7 1 BroadBaseDipTypelD TYPE

8 1 SlopeShapelD SLOPE SHAP
9 1 DischargeTolD DISCHRG T
10 |1 ObstructionID OBSTRUCT
11 |1 FillErosionID FILL EROS
12 |1 BroadBaseDipConditionID | CONDIT

13 |1 MateriallD MATERIAL
14 |2 Cdate Date

15 |2 Ctime Time

16 |2 VehicleID Vehicle

17 |2 DrainlD DRAIN ID

18 |2 StreamConnectID STREAM CON
19 |2 Comments COMMENT
20 |2 SlopeShapelD SLOPE SHAP
21 |2 DischargeTolD DISCHRG TO
22 |2 ObstructionID OBSTRUCT
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23 |2 FillErosionID FILL EROS
32 |3 Cdate Date

33 |3 Ctime Time

34 |3 VehiclelD Vehicle

35 |3 DrainlD DRAIN ID

36 |3 StreamConnectID STREAM CON
37 |3 Comments COMMENT
38 |3 SizelD SIZE

39 |3 PipeLength PIPE LEN
40 |3 DitchReliefTypelD TYPE

41 |3 DitchReliefConditionID CONDIT _

42 |3 SlopeShapelD SLOPE SHAP
43 |3 DischargeTolD DISCHRG TO
44 |3 FillErosionID FILL EROS
45 |3 ObstructionID OBSTRUCT
46 |3 FlowDiversionlD FLOW DIVER
47 |3 FlowDiffuserID FLOW_DIFFU
49 | 4 Cdate Date

50 | 4 Ctime Time

51 |4 VehicleID Vehicle

52 |4 DrainID DRAIN ID

53 |4 StreamConnectID STREAM CON
54 | 4 Comments COMMENT
55 4 SlopeShapelD SLOPE SHAP
56 4 DischargeTolD DISCHRG TO
57 |4 LeadOffConditionID CONDIT

58 | 4 ObstructionID OBSTRUCT
60 |5 Cdate Date

61 |5 Ctime Time

62 |5 VehiclelD Vehicle

63 |5 DrainID DRAIN ID

64 |5 StreamConnectID STREAM CON
65 |5 Comments COMMENT
66 |5 NonEngConditionID CONDIT

67 |5 SlopeShapelD SLOPE SHAP
68 |5 DischargeTolD DISCHRG TO
69 |5 ObstructionID OBSTRUCT
70 |5 FillErosionID FILL EROS
71 |6 Cdate Date

72 |6 Ctime Time

73 |6 VehiclelD Vehicle

74 |6 DrainID DRAIN ID

75 |6 StreamConnectID

76 | 6 Comments COMMENT
77 16 StrXingTypelD TYPE

78 | 6 PipeDimID R PIPE DIA
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79 16 PipeDimID(Oval) OVAL PIPE
80 |6 PipeLength PIPE LEN

81 | 6 FillDepth FILL DEPTH
82 |6 StrXingConditionID CONDIT

83 | 6 FillErosionID FILL EROSN
84 | 6 ChannelAngleID CHAN_ANGL
85 |6 BlockTypelD BLOCK TYP
86 | 6 OutletDrop OUTLET DRP
87 | 6 PoolDepth PL DEPTH

88 | 6 PipeGradient PIPE GRADE
89 | 6 SubstratelD SUBSTRATE
90 |6 DebrisFlowID DEBRIS FLW
91 |6 DiversionID DIVERSION
93 |7 Cdate Date

94 |7 Ctime Time

95 |7 VehiclelD Vehicle

9% |7 DrainlD DRAIN ID

97 |7 StreamConnectID STREAM CON
98 |7 Comments COMMENT
9 |7 SumpConditionID CONDIT

100 | 8 Cdate Date

101 | 8 Ctime Time

102 | 8 VehicleID Vehicle

103 | 8 DrainID DRAIN ID
104 | 8 StreamConnectID STREAM CON
105 | 8 Comments COMMENT
106 | 8 WaterBarTypelD TYPE

107 | 8 SlopeShapelD SLOPE SHAP
108 | 8 DischargeTolD DISCHRG TO
109 | 8 ObstructionID OBSTRUCT
110 | 8 FillErosionID FILL EROS
111 | 8 WaterBarConditionID CONDIT

112 | 6 PipeNumberID PIPE NUM
114 | 0 Cdate Date

11510 Ctime Time

116 | 0 VehicleID Vehicle

117 10 RoadTypelD ROAD TYPE
118 | 0 RSAMDIDI1 1 Drain ID
119 | 0 RSAMDID?2 2 Drain ID
120 | 0 SurfaceTypelD SURF TYPE
121 1 0 SurfaceConditionID SURF COND
122 10 RoadEdgelID RD EDGE 1
123 10 RoadEdge2ID RD EDGE 2
124 | 0 EdgeVegetationl1ID EDGE VEG 1
125 1 0 EdgeVegetation2ID EDGE VEG 2
126 | 0 EdgeCondition11D EDG CND 1
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127 1 0 EdgeCondition2ID EDG CND 2
128 | 0 FlowPath1ID FLOW_ PATHI
129 | 0 FlowPath21D FLOW_ PATH2
130 | 0 FlowPathVeglID FLWPTH VGl
1310 FlowPathVeg2ID FLWPTH VG2
1320 FlowPathCond1ID FLWPTHCNDI1
13310 FlowPathCond2ID FLWPTHCND2
134 | 0 FillChannelID FILL CHAN
13510 HUC6Name HUC6NAME
136 | 0 Miles MILES
13710 Comments COMMENT
13810 SurfaceCoverID SURF COV
139 1 0 OrigSourceCode FID 1
DPErrorLog Table Structure

Field Name Description
Index Unique identifier (Auto number in MS Access)
GRAIPDID Identifier from DrainPoints table

DrainlD Identifier from USFS road inventory

DrainType Type of the drain point (Eg: Broad Base Dip)
ErrorMessage Validation error message
ActionTaken Action taken to correct error

RDErrorLog Table Structure

Field Name Description
Index Unique identifier (Auto number in MS Access)
GRAIPRID Identifier from RoadLines table
RoadID Identifier from USFS road inventory
RoadType Type of road line (Eg: System road)
ErrorMessage Validation error message
ActionTaken Action taken to correct error
MetaData
ID | IDFieldName DefinitionTable
1 | DrainTypelD DrainTypeDefinitions
2 | VehicleID VehicleDefinitions
3 | StreamConnectID StreamConnectDefinitions
4 | BroadBaseDipTypelD BroadBaseDipTypeDefinitions
5 | SlopeShapelD SlopeShapeDefinitions




6 | DischargeTolD DischargeToDefinitions

7 | ObstructionID ObstructionDefinitions

8 | FillErosionID FillErosionDefinitions

9 | BroadBaseDipConditionID | BroadBaseDipCondDefinitions
10 | MateriallD MaterialDefinitions

11 | DitchReliefTypelD DitchReliefTypeDefinitions
12 | DitchReliefConditionID DitchReliefCondDefinitions
13 | FlowDiversionID FlowDiversionDefinitions
14 | FlowDiffuserID FlowDiffuseDefinitions

15 | LeadOffConditionID LeadOffCondDefinitions
16 | NonEngConditionID NonEngCondDefinitions
17 | StrXingTypelD StrXingTypeDefinitions

18 | PipeDimID PipeDimDefinitions

19 | PipeNumberID PipeNumberDefinitions

20 | StrXingConditionID StrXingCondDefinitions

21 | ChannelAngleID ChannelAngleDefinitions
22 | BlockTypelD BlockTypeDefinitions

23 | SubstrateID SubstrateDefinitions

24 | DebrisFlowID DebrisFlowDefinitions

25 | DiversionID DiversionDefinitions

26 | SumpConditionID SumpCondDefinitions

27 | WaterBarTypelD WaterBarTypeDefinitions
28 | WaterBarConditionID WaterBarCondDefinitions
29 | RoadNetworkID RoadNetworkDefinitions
30 | RoadTypelD RoadTypeDefinitions

31 | SurfaceTypelD SurfaceTypeDefinitions

32 | SurfaceConditionID SurfaceConditionDefinitions
33 | SurfaceCoverID SurfaceCoverDefinitions
34 | RoadEdgelID RoadEdgeDefinitions

35 | RoadEdge2ID RoadEdgeDefinitions

36 | EdgeVegetation1ID EdgeVegetationDefinitions
37 | EdgeVegetation2ID EdgeVegetationDefinitions
38 | EdgeCondition1ID EdgeConditionDefinitions
39 | EdgeCondition2ID EdgeConditionDefinitions
40 | FlowPathVeglID FlowPathVegDefinitions
41 | FlowPathVeg2ID FlowPathVegDefinitions
42 | FlowPath1ID FlowPathDefinitions

43 | FlowPath2ID FlowPathDefinitions

44 | FlowPathCond1ID FlowPathCondDefinitions
45 | FlowPathCond2ID FlowPathCondDefinitions
46 | FillChannellD FillChannelDefinitions
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APPENDIX 3

TAUDEM STREAM NETWORK SHAPEFILE ATTRIBUTE TABLE

The TauDEM stream network delineation function produces a stream network

shapefile with the following attribute table.

Field Description

LINKNO Link Number. A unique numl?er agsociated with each link
(segment of channel between junctions)

DSLINKNO Link Number of the downstream link. -1 indicates that this does
not exist.

USLINKNOI Link Number of first upstream link

USLINKNO2 Link Number of second upstream link.
Node identifier for node at downstream end of stream reach. This

DSNODEID identifier corresponds to the "id" attribute from the Outlets
shapefile used to designate nodes.

Order Strahler Stream Order

Length Length of the link

. Shreve Magnitude of the link. This is the total number of sources

Magnitude
upstream
Drainage area at the downstream end of the link. Generally this is

DS Cont Ar one grid cell upstream of the d‘ownstr‘eam end because the drainage

- - area at the downstream end grid cell includes the area of the

stream being joined.

Drop Drop in elevation from the start to the end of the link

Slope Average slope of the link (computed as drop/length)

Straight L Straight line distance from the start to the end of the link

US Cont Ar Drainage area at the upstream end of the link
Watershed number. Cross reference to the *w.shp and *w grid

WSNO files giving the identification number of the watershed draining
directly to the link.

DOUT END Distance to the outlet from the downstream end of the link

DOUT_START Distance to the outlet from the upstream end of the link

DOUT MID Distance to the outlet from the midpoint of the link

The following fields that record sediment inputs to the stream network and habitat

patch clusters are added to the TauDEM stream network shapefile by the GRAIP model.
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Field Description
Accumulated upstream sediment load from road surface at the
SedAccum
downstream end of each stream segment (kg/yr)
. Direct sediment input from road surface to each stream segment
SedDir
(kg/yr)
Specific sediment accumulation to each stream segment defined as
SpecSed accumulated upstream sediment production divided by upstream
p contributing area at the downstream end of each stream segment
(Mg/km®/yr)
SpecSedDir Direct specific sediment input to each stream segment divided by
P the direct area draining to each stream segment (Mg/km®/yr)
HabPatchID A unique identifier for each contiguous habitat cluster as

demarcated by fish passage barrier
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APPENDIX 4

GRAIP PREPROCESSOR TOOL TUTORIAL

Introduction

The GRAIP Data Preprocessor Tool is a software utility developed to validate and
import USFS inventory shapefile attributes into a relational database structure created in
MS Access file format. The purpose of this database (the GRAIP Database) is to enforce
referential integrity and ensure consistency between related attributes. The tool helps to
screen out invalid or corrupt data and provides the user with a better dataset to continue
with forest road impact analysis. It also consolidates multiple drain point and road line
shapefiles and creates a single shapefile for each. This appendix presents a tutorial

example to illustrate the working of the GRAIP Database Preprocessor tool

Getting Started

The setup file required for running the tool can be downloaded from

www.engineering.usu.edu/dtarb/graip. The GRAIP tool setup is called

“GRAIPSetup.exe” and it includes a sample dataset in a zipped file (*.zip) format named
“demo.zip”. This zip file contains a tutorial folder which contains the “dem” (ESRI
Raster Grid) file and a shapefiles folder containing eight types of drain points shapefiles
(BBdip.shp, Diffuse.shp, Ditchrel.shp, Lead off.shp, ned.shp, Str Xing.shp, sump.shp,

waterbar.shp) and one road lines shapefile (road.shp).


http://www.engineering.usu.edu/dtarb/graip
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Download GRAIPSetup.exe and save it to your working folder. Double click to
run the setup. This will install GRAIP in the designated folder (by default C:\Program

Files\GRAIP)

The GRAIP installation includes

1) GRAIPPreprocessor.exe, consolidateShp.dll, agGRAIP.dIl and
graipCOMDLL.dIl: An executable and binary libraries.

2) GRAIP.mdb: Template database in folder "graip db".

3) A tutorial folder that contains tutorial documentation and zipped
demonstration data.

4) A shortcut to the GRAIP Database Preprocessing tool will be created on

the in the Start-> Programs menu

GRAIP Database Preprocessor

Start the GRAIP Database Preprocessor Tool by clicking the windows “Start”
button and going to the All Programs -> GRAIP menu and clicking GRAIP Database

Preprocessor icon. The File Definition screen will be displayed as shown in Figure 1.
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Define Files

[*| Pre-process @

GRAIP Preproceszor iz a tool to impart S0 Forest Service road inventony information inko a M5 Access
databaze.

Project File

| D:\demahtest.graip ||

Input Files
DEM File ["zta.adi" inzide the DER Folder)

| D:\DEMONDEMAde L.

Road Shapefiles
D:ADEMONS hapeFileztRoad.shp Add

“oel |

Drain Points Shapetiles

5 @& 066

O:ADEMONShapeFilez BB dip.shp ) Add
D:ADEMOMNShapeFilezhDiffuse. shp
D:ADEMOMNShapeFileshDitchB el shp Del
D:ADEMONShapeFilestLeadOff.shp
O:ADEMONShapeFileshMed. shp
D:'xDEMEI"-.ShapeFiIes"-.Str_King.shp v
GRAIP Database [*.mdb]
D:Hdemu\test.mdb‘g
Options LCancel | Mest » |

Figure 1: File Definition Screen.

1. Start by unzipping demo.zip file to working folder (eg:- C:\demo).

2. Click on the More Button (...) next to the Project File field of test.graip. In the
Save Project dialog select a folder and enter a file name for the new GRAIP
Project file to be created

3. An initial path and file name for GRAIP Database file (E) will be generated based

on the path and file name selected in step 1.
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4. Click on the More button (...) next to DEM file field (B). Browse to the working
folder and select the dem\sta.adf file and click “OK”. Figure 2 shows the location

of the DEM sta.adf file used in this example.

Select Folder

File name: Folders: 0k
|Sta_adf d:\dematdembdem _
Cancel
dblbrd. adf [== d:
hdr. adf = demo
rj. adf = DEM
wO01007. adf = dem
wO07007 . adf
Lizt files of type: Dirives:
|DEM File[* adf] x| | B dMyLie | Network..

Figure 2: The “Select Folder” dialog shown when the More (...) button next to the
“DEM File” field is clicked

5. Click on the “Add button adjacent to Road Shapefiles field (C). Select the
\Program Files\GRAIP\tutorial\Demo\Shapefiles\Road.shp file and click “OK”.

6. Click on the “Add” button adjacent to Drain Points Shapefiles field (D). Select the
\Program Files\GRAIP\tutorial\Demo\Shapefiles\ directory. Select the following
files from that directory by holding down the “Ctrl” key and clicking on each
filename in the File name list: BBdip.shp, Diffuse.shp. DitchRel.shp,
LeadOff.shp, Ned.shp, Str Xing.shp, Sump.shp, WaterBar.shp. Release the “Ctrl”
key and click on “OK”.

7. Click the “Options” button to change Message options. (See Figure 3). If you
choose to override the error messages the program will run to the end accepting
the default choices for field matches and resolving undefined values. This is

useful if a user knows the defaults are satisfactory.
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8. Click “Next”.

9. You should see that a new GRAIP project file (TBtest.graip) has been created
which holds the information about the file paths. A new MS Access database file
(TBtest.mdb) should also have been created at the specified GRAIP Database
path. All the shapefile attributes will be validated and stored inside this database

file.

Error Meszage
{* Show Message [Default}

" Over ride eror meszages
-
Log Filez

Cirain Paint

| D:vdemostestDPlog

Road

Cancel | Set |

Figure 3: Options dialog to over ride error message and change the paths and/or file
names of the log files

Import Drain Points Attributes

The Drain Points Import Screen is shown in Figure 4. (A) displays the path of the
drain point shapefile to be imported from the shapefiles selected earlier. (B) shows
the Drain point type which is automatically selected by the program based on the
name. This can be changed if necessary. (C) displays the table with Target Fields that
will be populated in TBTest.mdb and Matching Source fields from the shapefile. The

tool will match the fields by default.
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1. Click on the row in the Matching Source Field column to change any default
fields that are not correctly matched automatically (See Figure 5). If a matching
field is not found “<No Match Use Default>" is selected by the tool.

2. Once you are satisfied with the matches click “Next”.

[~ Preprocessor:1 of 9 @

katch a zource field from the input file to the appropriate target field in the databasze table

Imputs from drain point file VR
| e )

Set Field Mames

Dirain Point Type B
Broad baze dip -

For each target field zelect the zource field that zhould be loaded into it.

T arget Field k atching Source Field @
CDate <MNao Match Use Default
CTime <Moo Match Use Default:
YehiclelD <MNao Match Usze Defaults
CrainlD CRAIM_ID
StreamConnectlD STREAKM_COM
Commerts COMMEMNT
BroadB azelipT ypelD Tv'PE Z

Figure 4: Drain Points Validate and Import dialog.
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[~| Preprocessor:1 of 9

bl atch a source field from the input file to the appropriate target field in the database table

|mputs fram drain point file

Set Field Mames

Drain Paint Type

Broad base dip ﬂ
For each target field zelect the zource figld that should be loaded inta it.
T arget Field b atching Source Field R
Chate <Mao Match Use Default:
CTirme ¢Mo Match Use Default:
WehiclelD <Mo Match Use Default:
DrainlD DRAIM_ID
StreamConnectiD STREAM_CON j
Comments DISCHRG T e
- STREAM COM
Broadk azeDipT ypelD OESTRUCT -
|FILL_ERDS
TvPE
CONDIT ¢Back [ New> |
MATERIAL
| COMMEMT o

Figure 5: Selecting the Matching Source Field.

3. If an attribute value is found which is invalid or misspelled, an Attribute Validate
dialog is displayed (See Figure 6). In that case either “reassign the value to an
existing preferred value in definitions table” or “Add new entry to preferred value
definitions table” or “Use default” and click “OK”. ”. This information is added to

the DPErrorLog table to verify later.



Add New Definition
Yalue 'Previouz' in field 'FlowDiversionl D not in defaulk definitions.

i+ Reazzign thiz value to an existing table definitions entry

Drefiritions

~

" Add new entry to definitions table

Definition Table |

ID|

D efinitiar |F"reviu:nus

Cescription |F"re'...'i|:|u3

Cancel | Ok |

Figure 6: Attribute Validate dialog.
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4. Once all of the invalid values in that drain point table are processed, the next drain

points validate and import screen is displayed. Continue these steps until all the

drain points are imported to the database.

5. Once all the drain points shapefiles are validated and imported, the Road Lines

import screen is displayed.

Import Road Lines Attributes

The Road Lines Import screen will be displayed as shown in Figure 7. (A)

displays the path of the road lines shapefile to be imported as selected earlier. (B)

shows the Road Network Type. This can be changed if necessary. (C) shows the Base

Rate associated with the road network type. (D) shows the Description for the base
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rate used. (E) shows the “+” button to add a new type of road network, associated

base rate and the description for the base erosion rate. The “-* button is to remove a

road network type record and its associated base erosion rate. The user does not have

the permission to remove the “Default” road network type record. (F) displays the

table with Target Fields that will be populated in TBTest.mdb and Matching Source

Fields from the shapefile. The tool will match the fields by default.

1. Click on the row in the Matching Source Field column to change the default fields
matched (Figure 8).

2. If a matching field is not found, “<No Match Use Default>" is selected by the
tool.

3. Once you are satisfied with the matches click “Next”.
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[~ Preprocessor: 9 of 9

Match a source field from the input file to the appropriate target field in the databaze table @

Foad Line .
| |

Set Field Wames

Base Erosj =
Road MNetwork @ [kgfmdvr]( C Dezcription D
=l

Crefault |

For each target field select the source figld that should be loaded inta .

Target Field bl atching S ource Field @
CDate <Moo Match Use Default: D
CTirne <Mo Match Use Default:
YehiclelD <Mo Match Use Default:
OrigSourceCode FID_1
RoadTppelD FOaD_TYPE
GRAIPDIDT 1_Drain_|D
GRAIPDID2 2_Drain_|D 2

Figure 7: Road Lines Import dialog



[~| Preprocessor: 9 of 9

Foad Line

bl atch a source field from the input file to the appropriate target field in the database table

Set Field Mames
Foad Metwark:

Baze Erozion Fate
[kadmdyr]

Drefault

Drescription

=1 |

For each target field zelect the zource figld that should be loaded inta it.

[

< Back | Mest » |

Target Field M atching Source Field
CDate ¢Mo Match Use Default:
CTirme <Mo Match Use Default:
YWehiclelD <Mo Match Use Default:
OrigSourceCode FID_1
FioadTypelD ﬂ
GRAIPDID <Mo Match Uze Default: Y
FID_1
GRAIPDIDZ SURF_TPE
SIRF_COMD
RO_EDGE_1
ROD_EDGE_2
| EDGE _YEG_1 b

Figure 8: Selecting the Matching Source field.
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4. 1If a Value is found which is invalid or misspelled an Attribute Validate dialog is

displayed (See Figure 9)

5. In that case either “reassign the value to an existing value in preferred value

definitions table” or “Add a new entry to definitions table” or select “Use Default

Value” and click “OK”. This information is added to the RDErrorLog table to

verify later.



Add New Definition
Yalue '0-20" in field 'FillChannelD' nat in default definitions.

i+ Reazzign thiz value to an existing table definitions entry

Drefiritions

~

" Add new entry to definitions table

Definition Table |

ID|

D efinition ||:|.2|:|

Description ||:|.2|:|

Cancel | Ok |

Figure 9: Attribute Validate dialog
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6. Once all the Road Line attributes are imported to the database, the tool checks for

drain points without any road segments draining to it and road segments that do

not drain to any drain point. These are referred to as orphans Identifiers of drain

points and road segments are stored in the error log tables and text files.
DPErrorLog, RDErrorLog for drain points and road segments respectively.

7. The consolidate shapefiles progress bar will appear while the shapefiles are

consolidated.

GRAIP Database Preprocessor Tool Output Files

Figure 10 gives a list of the output files created by the GRAIP Database Preprocessor

tool.



Mare ¢ Size | Tvpe

1DEM File Folder
3 shapefiles File Faolder

DrrainPoints . dbf 4 KB  Microsoft Wisual Foo...
DrainPaoinks.shp 10KE SHP File

DrainPoinks, shx 3KB SHx File

Roadlines. dbf A0 KB Microsoft Wisual Fox...
RoadLines.shp 2,423 KB SHP File
RoadLines.shx ESKE  SH File
@test.mdb 10,936 KB Microsoft Access Ap...
best.rsap 1KE RSAP File
testDP.log 1KE Text Document
testRD.log 7EKB  Text Documnent

Figure 10: GRAIP Database Preprocessor Tool output files
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APPENDIX 5

GRAIP GIS TooL TUTORIAL

GRAIP GIS model is an ArcGIS 9.1 toolbar developed to analyze the impact of
forest roads on forest watersheds. This tutorial describes how to install and use the set of
tools needed to perform a GRAIP analysis. These tools consist of the GRAIP

Preprocessor, GRAIP GIS Tool, SINMAP2.0, TauDEM and Hawth's tools.

Installation

1. TauDEM: The website http://hydrology.neng.usu.edu/taudem/ explains

how to install and use the TauDEM toolbar.

2. SINMAP2.0: The website http://hydrology.neng.usu.edu/sinmap2

explains how to install and use the SINMAP toolbar.

3. Hawth's Tools: The website http://www.spatialecology.com describes how

to install and use Hawth's analysis tools.
4. GRAIP and GRAIP Preprocessor: The website

http://www.engineering.usu.edu/dtarb/graip provides a link to the GRAIP

tool setup file: “GRAIPSetup.exe”. Download GRAIPSetup.exe and save
it to your working folder. Double click to run the setup. This will install
GRAIP in the designated folder (by default C:\Program Files\GRAIP).
This includes both the preprocessor and ArcMap toolbar. Use of the

preprocessor is described in a separate preprocessor tutorial.


http://hydrology.neng.usu.edu/taudem/
http://hydrology.neng.usu.edu/sinmap2
http://www.spatialecology.com/
http://www.engineering.usu.edu/dtarb/graip
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Getting started

To activate the GRAIP toolbar open ArcMap, go to the “Tool” menu and click

“Customize” dialog, Figure 1, should open.

Customize

Toolbars | Commands ] Optians ]

Toaolbars:

[ Diszonnected E diting |
Ciraw
Editar |

[
=
[n1]
=

[] Effects

[1GPS

[1 Geametric: Metwark E diting
[1 Geareferencing

[1 Geostatiztical Analyst

[] Graphics

[1Labeling

Layaut

[1Map Cache

[1 Metwark Analpst b

Kevboard... Add fram file...

Figure 1: ArcMap Tool Customize dialog.
Click “Add from file...” and browse to \Program Files\GRAIP and select the
agGRAIP.dII file. Check the “Geomorphologic Road Analysis and Inventory Package”

box (Figure 2) to make the toolbar (Figure 3) visible.
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Customize

Toolbars | Commands ] Optiong ]

Toolbars:

Editor A Mew... |

[] Effects

[1GPS |
|

[1 Geometric Nebwork Editing
Geomarphologic Boad Analysis and Inventon Pack,

[] Geareferencing Reset
|j aeomorphologic Road Analysis and Inventory Package{GRAIP) 1L1
[] Graphics

Hawth's Toolz

[1 Labeling

Lapout

[ Map Cache

[1 Metwark Analypst v

Kevboard... Add from file...

Figure 2: Check box to display GRAIP toolbar.

Geomorphologic Road Analysis and Inventory Package{GRAIP)

File * Preprocessor ™  Road Surface Erosion Analysis ™ Mass \Wasking Potential Analysis ¥ Habitak Segmentation Analysis * ¥ (’

Figure 3: GRAIP ArcMap Toolbar.

Toolbar Overview

The GRAIP toolbar functionality is divided into following parts (Figure 3)

1) Project settings file management (A).
2) Database preprocessor (B).
3) Road surface erosion analysis to quantify sediment production from forest roads

and its delivery to streams (C).



172

4) Mass wasting potential analysis to quantify the impact of forest roads on terrain
stability and gullying potential (D).
5) Habitat segmentation analysis to analyze and demarcate fish habitat segmentation
due to failed or blocked culverts (E)
In addition to above features there are two extra tools to trace the road segments draining
to a particular drain point (F) (Drain Rex, Rex being the faithful dog to sniff out where
road segments drain) and to find drain points where a particular road segment is draining

to (G) (Road Rex).

The following sections in this tutorial describe the steps taken in a typical GRAIP

analysis.

Data Preparation

1) Run the GRAIP Database Preprocessor tool
2) Run TauDEM Basic Grid Analysis and Network Delineation functions to delineate a

TauDEM stream network.

Running the GRAIP GIS Tool

The *.graip file created by the GRAIP database preprocessor contains information about

input file paths for GRAIP GIS model.

1) From within ArcMap open the *.graip file by going to “File” -> “Open” in the
GRALIP Toolbar (Figure 4). Browse to and select the *.graip file. The DEM,
DrainPoints.shp, RoadLines.shp and demnet.shp files required for the analyses

will then be displayed in ArcMap (Figure 5).
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Geomorphologic Road Analysis and Inventory Package(GRAIP) X

File * Preprocessor > Rioad Surface Erosion Analysis = Mass Wasting Potential Analysis = Habitat Segmentation Analysis = 4 (’

Save

Save as..,

File Management

Figure 4: File Open Menu to open the Project settings file.

Table of Contents X
EEzd avers|

- CrainPoinks
@
- RoadLines

- demnet

- dem
Walue
High : 2478.52

Loww o 1046.67

Display |S|:uurn:el Selectiun]

Figure 5: ArcMap Table of contents showing GRAIP analyses input files loaded.
When the *.graip files is used to load files the RoadLines and DrainPoints shapefiles
are joined to the corresponding in the GRAIP Database (*.mdb) so that attributes are

accessible (Figure 6).

B Attributes of Roadlines

I
H 0 |Polyline 0 3 1 1 —
H 1 |Polyiine 1 E 1 1
B 2 |Polyline 2 3 1 1
H 3 |Polyline 3 3 1 1
H 4 |Polyline 4 3 1 1
* 5 |Palyline 5 3 1 1
| & |Palviine & 3 1 1 st

< |

Recond: ﬂﬂ B ﬁﬂ Show:W Selected | Records [0 out of 1025 Selected.] Options =

|

Figure 6: RoadLines shapefile attribute table joined to MS Access RoadLines table.
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2) To manage the file paths for input, intermediate and output files, go to File ->
File Management menu to open the File Management Dialog (Figure 7)
. test Properties E|
Base Inputs l Intermediate Files and Dutputs] Field Mames ]

|nput Files DEM File
|D:ADEMONDEM dem

Fioad Shapefiles

|DZ"-.I:|EI'I'II:I"-.H nadLinesz. shp

Drrain Paints Shapefiles

|DZ"-.I:|EI'I'II:I"-.D rainiFoints. shp

FiSakd D atabaze Folder [*.mdb]
|D:"-.|:Iem|:|'\test.mdl:|

R eszet Canicel Ok

Figure 7: Base Inputs file information in File Management Dialog.

3) Select the Resample DEM function from the GRAIP Preprocessor menu. This
function (Figure 8) resamples a DEM to a finer scale using the cubic convolution

method from the ArcGIS Toolbox.



. Resample

[nputs

[rput DE R
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X

|D:\DEMDHDEMHderrJ

Output Cell Size

Output Fine Scaled Pits Filled Digital Elewvation kodel

-]

5

D:ADEMONDEMNdermr

N
Cancel | Compute |

Figure 8: DEM Resample Function Dialog.

4) Select the Extract Stream Crossings function from the GRAIP Preprocessor menu.

This function extracts the stream crossing drain points from the consolidated

DrainPoints shapefile created by the Database Preprocessor tool.

5) Use the Hawth's Tools -> Vector Editing -> Intersect lines (make points) function to

intersect the Road lines with the preliminary stream network. Name the output

StrXingRi.shp (Figure 9).



H [ Intersect Lines (Make Points) g@@

[Fput

| RoadLines
-

[ Retain attributes from this lawer

Line/poly layer:

Interzect line/poly layer: |':|‘3""'”Et

Cukput
Output point zhapefile:

|D:SdemotS iingRi. shp
[w Add output layer to Arckdap after processing

i

[

weh Help 0K | Esit |

Figure 9: Hawth's Intersect Lines Tool Dialog.

6) Snap stream crossings to the preliminary stream network. Use Hawth's Tools ->

Vector Editing -> Snap points to lines tool to snap the extracted stream crossings
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shapefile to the nearest position on the TauDEM stream network shapefile resulting in

a new point shapefile (StrXingSn.shp) (Figure 10).

H Snap Points To Lines

[rput

X|

Paint Feature: laper: |StixingEx

Lirne or polpgon feature layer: |':|'3""'”'E’t

Parameters

Search tolerance diztance [in map unitz]: 1000

Cukput

Mew point layer to create:;

El
[

|D:'\dem-:u"-.5 t<ingSn.zhp

i

£

weh Help 0K, | Esit |

|

Figure 10: Hawth's Snap Points to Lines Tool Dialog.
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7) Filter Stream Crossings. Use GRAIP -> Preprocessor -> Filter Stream Crossings
function to automatically associate the appropriate points on the stream network from
the snapped stream crossings (StrXingSn.shp) and road stream intersections
(StrXingRi.shp) with nearby surveyed stream crossings screened according to
nearness and a geomorphologically derived channel width criterion (Figure 11). The
output is three shape files containing all merged stream crossings (MergedSX.shp),
matched stream crossings (MatchSX.shp) and unmatched stream crossings

(UMatchSX.shp).

| Filter Stream Crossings

Input
Extracted Stream Crozsings

|D:"«demu:u"~5tr><ingE:-:.shp
Hawth Shapped Stream Crozzing Shapefile

-]
|D:'\|:Iem|:|'\.5 ti<ingSn.zhp J
L
]

Hawth Road Stream Intersection Shapefile

|01 demotS tixingRii. shp
Contributing Area Grid

|D:"~DEMD'\DEM"-.cIemacIE

Filter Cntena

l[Chan_‘width - Geolwl[Chan_\Width+Geolw) / 2 <= | 03
Mearest Stream Crozzing Diztance [m) <= | 100
Dutput
berged File
|D:'\demu:u"-.MergedS><.shp J

katched Stream Croszsings Shapefile

|D:4demaMatchSi, shp

nmatched Stream Crozsings Shapefile
[0 dematUMatchS, shp .

Cancel | Compuite |

Figure 11: Filter Stream Crossings function.
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Check matched and unmatched on-stream points, manually editing and resolving
mismatches where possible or identifying situations requiring further examination in
the field. The goal of the filter at the step above was to position each surveyed stream
crossing from StrXingEx.shp on the stream network. This was attempted by
examining both the nearest position on the stream to which the stream crossing can be
snapped (StrXingSn.shp) and the nearest road stream intersection (StrXingRi.shp).
Points where one of these passed the matching criteria are in MatchSX.shp. The user
should in most cases be able to accept these without further analysis. The surveyed
stream crossings for which there was no match found are placed in UMatchSX.shp.
The user should examine each of these to verify why they are not able to be placed on
a stream and make the appropriate edits.

Combine the matched on-stream points shapefile with the overall outlets shapefile
renumbering the Id field to avoid Id duplicates between the on-stream points and
overall outlets. A simple way to combine shapefiles is to start editing the outlets
shapefile, then select all the points in the MatchSX.shp shapefile and copy, then paste
them into outlets.shp. A simple way to renumber the Id field is to use calculate

values to set Id equal to Fid.

10) The combined outlets + stream crossings shapefile is then specified as the outlets

shapefile for running the TauDEM network delineation functions. Use Preprocessor -
> Create TauDEM Stream Network function to run the TauDEM network delineation
function. With the new outlets shapefile as input TauDEM creates a stream network

shapefile with stream segments split at stream crossings.
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Road Surface Erosion Analyses

The functions on the GRAIP toolbar menu “Road Surface Erosion Analysis”

(Figure 12) should be run in sequence from top to bottom.

eomorphologic Road Analysis and Inventory Package{GRAIP)

File * Preprocessor ¥ | Road Surface Erosion Analysis *  Mass Wasting Potential Analysis *  Habitat Seqmentation Analysis = % r"

Rioad Segrent Sediment Praduction

Drain Poink Sedimeant Accumulation
Accurulated Upstream Sediment Load

Accumulated Upstream Specific Sediment
Upstream Stream Sediment Input

Direct Stream Sediment Input

Figure 12: Road Segment Sediment Production Menu
1) Road Segment Sediment Production: Use Road Surface Erosion Analysis -> Road
Segment Sediment Production function to calculate the sediment production
values at each stream segment. Road Segment Sediment Production Analyses tool

dialog is opened (Figure 13)

. Rpad Sediment Production

[rputs
Foad Shapefiles

|D:"'.|:Iem|:|"-.Fi nadLines. shp

|nterpolated Digital Elevation kModel
|D:\DEMONDEM dernr J

Output
The Figldz SedProd_1 [kagdvr), SedProd_2 [kgdwr). Length [m), UnitSed [(kasmdvr], Slope will be appended
to Fload Lines table

Figure 13: Road Sediment Production tool dialog.
Click compute to calculate sediment production values. The following fields are

populated in the RoadLines table in the GRAIP database (*.mdb file)
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a) Length : Road length (meters)

b) SedProdl: Sediment production from one side of road (kg/yr)

c) SedProd2: Sediment production from other side of road (kg/yr)

d) UnitSed: Unit sediment production from the road segment (kg/m/yr)

e) TotSedProd: SedProd1+SedProd2 (kg/yr)

f) TotSedDel: Sediment delivered to streams (calculated using stream
connection information for each road) (kg/yr)

g) UnitTotSedDel: TotSedDel/Length (kg/m/yr)

2) Drain Point Sediment Accumulation: Use Road Surface Erosion Analysis ->Drain

Point Sediment Accumulation function to open the tool dialog (Figure 14)

| Sediment Accumulation at Drain Points E|E|E|

Inputs
Road Shapefiles

|D:"~demn:|'xH aadlines. shp

Dirain Pointz Shapefiles

|D:"u:|emn:n'\DrainF'n:-ints.shp

Output

The Fieldz SedProd [kadw], UnitSed [kodmder] and ELength [Effective Length in m) will be appended to
the DranPaoints table in GRAIP D atamadel.

Cancel | Compute |

Figure 14: Drain point sediment accumulation tool dialog.
Click the compute button to calculate and store sediment accumulation values at each

drain point in the DrainPoints Table in the GRAIP database.

The following drain point fields are populated
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a) SedProd: Total accumulated sediment load at each drain point due to road
surface erosion (kg/yr)
b) ELength: Effective length of road draining to each drain point (meters)
c) UnitSed: SedProd/Elength (kg/m/yr)
d) SedDel: Sediment delivery depending on stream connection (kg/yr)
4) Accumulated Upstream Sediment Load: Use Road Surface Erosion Analysis->
Accumulated Upstream Sediment Load function in the GRAIP toolbar to open

the tool dialog (Figure 15)

| Accumulated Upstream Sediment Load

Input
Drain Pointz Shapefiles

|D:"u:|emu:u"~D rainiFoints. shp
D3 [default]/Dinf Flow Direction

|D:HDEMD&DEM'\demp
(* Stream Connected € Tatal Sediment Production

Output
Sediment Production wWieight Grid.

|D:\DEMOADE M demswit
Accumulated Upstream Sediment Load.

D:ADEMONDEM\demsac

f« |ze D8 Contributing Area Function i Use Dinf Contributing Area Function

[vw Add Layers to the Map Cancel | Compute |

Figure 15: Accumulated Upstream Sediment Load dialog with default file names and
options.

Click the compute button and following output grids are created.

a) Weight grid with Drain Point accumulated sediment load (swt suffix)
b) Weighted Sediment Accumulation grid (sac suffix). The user can select

between D8 and Dinf Contributing area functions.
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5) Accumulated Upstream Specific Sediment: Use Road Surface Erosion Analysis->
Accumulated Upstream Specific Sediment function to open the tool dialog (Figure

16)

| Specific Sediment Accumulation

Output
Accumulated Upstream Sediment Load.
D:\DEMO'DEM\demsac ]
| pstream Contributing Area
|D:'\DEMD"~DEM'&demadB J
Output

Specific Sediment Accunmulation
D:\DEMO\DEM'demspe .

[v Add Laver to the Map Cancel | Compute |

Figure 16: Specific Sediment Accumulation Dialog with default file names. User has the
option to change input and output file names.

Click compute to create upstream specific sediment accumulation grid (Suffix spe)

6) Upstream Stream Sediment Input: Use Road Surface Erosion Analysis->

Upstream Stream Sediment Input function to open the tool dialog (Figure 17)
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i, Accumulated Upstream Sediment Load For Stream Hetwork

Input
Fit Filled DER

|D:"~DEI'-1EI"~DEM'\|:IemfeI

Accumulated Upstream Sediment Load.

|D:ADEMONDEM demsac
| pstream Contributing Area

|
]
|

Stream Metwark,

|D:'\DEI‘-1EI"~DEM"~|:Iemnet.shp

Output
The Figldz Sediccun and SpecSed will be appended ta the Stream netwark, attribute table.

Seddcoum containg sediment load far the downstream end of each stream zegment in kgl
SpecSed containz sediment load per unit area of the downstream end of each stream segment in

b gy o
Cancel | Compute |

Figure 17: Accumulated Upstream Sediment Load for Stream Network with default file
names and paths.

Click the compute button to calculate the upstream sediment inputs and specific

upstream sediment inputs to each stream segment. Outputs from this function are

a) SedAccum: Accumulated Sediment Inputs to each stream segment (kg/yr)
b) SpecSed: Accumulated Specific Sediment load in each stream segment
(Mg/km?/yr)
These are appended to the stream network shapefile (*net.shp)
7) Direct Stream Sediment Input: Use Road Surface Erosion Analysis->Direct Stream

Sediment Input to open the tool dialog (Figure 18)
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. Direct Sediment Production-Stream

Input
Pit Filled DE M

|D:HDEMD'\DEM"-.cIemfeI

Accumulated Upzstream Sediment Load.

D:\DEMONDEM\demsac

|D:"~DEMD'\DEM"-.cIemacIE

Strearm Metwark,

|D:HDEMD'\DEM"-.::Iemnet.Shp

]
5 =
|Ipztream Contributing Area
L
]

Output

The Fieldz SedDir and SpecSedDir will be appended to the Stream network. attribute table.

SedDir containg sediment load for the area draining directly to each stream zegment in kaor.
SpecSedlir containg sediment load per unit area draining directly to each stream segment in b ogderdmé

Cancel | Compuite |

Figure 18: Direct Stream Sediment Input dialog with default file path.
Click the compute button to calculate the direct upstream sediment inputs and direct
specific upstream sediment inputs to each stream segment. Outputs from this function

arc

a) SedDir: Direct Sediment Inputs to each stream segment (kg/yr).
b) SpecSedDir: Direct Specific Sediment load in each stream segment
(Mg/km?/yr).

These are appended to the stream network shapefile (*net.shp).

Mass Wasting Potential Analysis

The functions on the Mass Wasting Potential Analysis Menu (Figure 19) should

be run in a sequence from top to bottom



Geomorphologic Road Analysis and Inventory Package{GRAIP)

File * Preprocessor *  Road Surface Erosion Analysis * | Mass Wasting Potential Analysis ™  Habitat Segmentation snalysis = 4 r"

Stability Index

Select Calibration Region Grid
Combined Stability Index

D& Slope with downslope averaging
Slope at Drain Paink

Erosion Sensitivity Index

Length Slope Plat

Stream Blocking Index

Figure 19: Mass wasting potential Analysis menu.

1) Stability Index: Use Mass Wasting Potential Analysis -> Stability Index function
to open the tool dialog (Figure 20). Before doing this function you have to run
SINMAP 2.0 to create the Stability Index (SI) grid. This SI grid is used as input in
this function. For more information and tool documentation on SINMAP 2.0

please visit http://hydrology.neng.usu.edu/sinmap2/

s X]

Input

Dirain Points Shapefiles

|D:Hdemn"~DrainF’u:uints.shp

|D:'\DEMEI"-.DEM'&SINMAF‘Data'\demSi

Output
1] The field 5l iz appended to the table of the Drain Point Shapefile(z). Stability Index at each drain point
eztimated fraom SIMMAP output interzected with the drain point feature clazs locations.

Cancel

Figure 20: Stability Index at each drain point.
Click compute to identify Stability Index grid values at each drain point and store

them in the DrainPoints table. The SI field is populated with values

2) Combined Stability Index: This function requires a calibration grid to run.

Calibration regions are areas within which single lower bound and upper bound


http://hydrology.neng.usu.edu/sinmap2/
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calibration parameters values can represent T/R, dimensionless cohesion, friction
angle (¢) and soil density (p). SINMAP 2.0 tool documentation at

http://hydrology.neng.usu.edu/sinmap?2/ gives more information on creating the

calibration region grid. To load the Calibration grid, click use Mass Wasting
Potential -> Select Calibration Grid function and browse to the calibration grid.
The grid is added to ArcMap when you select the grid. Now you can run
Combined Stability Index using Mass Wasting Potential -> Combined Stability
Index function. A tool dialog with default parameters and input and output file

names will open (Figure 21)


http://hydrology.neng.usu.edu/sinmap2/
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i, Combined Stability Index @

Input
Dirain Points Shapefiles

|D:‘~demn'\DrainF‘nints.shp

Road Shapefilez

|D:"u:|em|:|"aFE oadLines. shp
Specify Boad ‘width [m]

| J Calibration Farameters Test File

|D:HDEMDHDEMHdemcaIp.csv J
Yiew/Edit Calibration Parameter File |

kinimum T errain Recharge [mdhr] bl awimumm T errain Fecharge [m/hr]

| 0.0003 | 0.00135

Finirmum Additional Foad Surface Bunoff [mdhr) b awimum Additional Road Surface Bunoff [mehr]

| 0.001 | 0.002

Dinf Slope

|D:"-.DEMEI"~DEMH::|emst

Dinf Specific Catchment Area

|D:'\DEMEIHDEMH::Iems-:a
Calibration Grid

Lk

|D:'\DEI‘v1EI‘-.DEI'v1'\dem|:aI

Output
Combined Stahbility |ndex Grid

|D:'xDEMEI"~DEM'x-:Iemsi|:

1] The field SIR iz appended to the table of the Drain Point Shapefile(z). Boad Stability Index at each drain
point estimated from SIMMAP output intersected with the drain point feature clazs locations.

[v idd Sl combined arid to the Mag Cancel | Compute |

Figure 21: Combined Stability Index function.
Minimum and Maximum Terrain and Road recharges are user adjustable. Click
View/Edit Calibration Parameter file button to open the table with modified SINMAP

parameter values (Figure 22). These parameters are user adjustable.
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B Parameter ¥alues Of the Calibration Grid E|@|E|
W alue Feqion Trnir Trnax Crmir Crnax PHIrnin PHIrmnax Rhos
1 Reqion 1 2708 2708 1] 025 30 45 2000
Save | Cancel

Figure 22: Calibration Parameter Table for single calibration grid selected.

The output and intermediate files created are

a) Minimum and maximum depth of terrain runoff generated (Suffix
rmin and rmax).

b) Specific discharge due to road drainage for Minimum runoff and
Maximum runoff (Suffix rdmin and rdmax ).

c) Combined Stability Index Grid (Suffix sic).

The intermediate outputs (a) and (b) are not added to the ArcMap

In this function stability index (SI) due to terrain contributing area can be
calculated by setting the road surface runoff to be 0 and SI due to road runoff only can be
computed setting terrain recharge to be 0. The SI values from the grid are used to identify

SI values to store in the SIR Field in for each drain point in the GRAIP database.

2) D8 Slope Grid with Downslope averaging: Use Mass Wasting Potential -> D8
Slope Grid with Downslope averaging function to open the tool dialog (Figure
23). Here the D8 flow directions are used to trace downslope and find the average

slope for each grid cell over the specified averaging distance.
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. D8 Slope Grid with dovwnslope averaging

Input

Fit Filled DEM

|D:'xDEMD'xDEh-1'xdemfeI

013 Flow Direction

Output

Downgradient Trace Distance d in Meters |50

08 Slope Gnd with dovnzlope averaging [d]

|D:A\DEMONDEM demp -

|D:"~DEMEIHDEM"-.|:Iemstd

[vw Add Layer to the Map Cancel | Compute |

Figure 23: Slope Grid with downslope averaging function dialog.

3)

The output from this function is the slope grid with downslope averaging (Suffix

slpd)

Slope at Drain points: Use Mass Wasting Potential Analysis -> Slope at Drain
Points function to open the tool dialog. Click compute to calculate the slope at
each drain point (Figure 24). Slope field in the DrainPoints table in GRAIP

database is updated with values.

il Slope At Each Drain Point
Input

Drain Paintz Shapefiles

|D:‘~demn'\DrainF‘nints.shp

D03 Slope Grid with Downzlope averaging [d]

|D:"-.DEMEIHDEM"-.|:Iemstd

Output
11 The field Slape iz appended ta the table of the Drain Paint Shapefile(z]. Slope at each drain paint
estimated from the Averaged D8 Slope Grid.

Cancel

Figure 24: Slope at each drain point.
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4) Erosion Sensitivity Index: Use Mass Wasting Potential Analysis -> Erosion

Sensitivity Index function to open the tool dialog (Figure 25).

il Erosion Sensitivity Index
Input

Drain Pointz Shapefiles

O:hdemotDrainPoints. shp

Exponent alpha 2

Output
1] The field ES| iz appended to the table of the Crain Point Shapefile(z).ES| iz evaluated LS alpha.

Lancel

Figure 25: Erosion Sensitivity Index at each drain point.
This function outputs the ESI values at each drain point: LS* where S is the slope and L

is the Effective length of the road draining to each drain point.

5) Length Slope Plot: Use Mass Wasting Potential Analysis -> Length Slope Plot
function to open the graph dialog with Length on the Y-axis and Slope on the X-

axis (Figure 26)
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o)X

Settings
Par Edit | Statistics L-S PLOT
7l Fegion: 1 -FPaints
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Drain Paoints: 1 Gullies: 1 Land slides: 1

Figure 26: Length Slope Plot.

6) Stream Blocking Index: Use Mass Wasting Potential -> Stream Blocking Index

function to open the tool dialog (Figure 27).

i, Stream Blocking Index @

Input
Drain Pointz Shapefiles

|D:'\demn"-.DrainF'u:uints.shp
Mote: Calculated only for Drain Paints for Stream Crozsing Drain points

Output

drain point.

1] The field SBI iz appended ta the table of the Dirain Point Shapefile. Stream Blocking Index indicates
plugaging zuzceptibility bazed upon the ratio of the pipe diameters ta channel width and zkew angle at each

Cancel

Figure 27: Stream Blocking Index function calculated at each drain point.
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Outputs from this function listed below are populated in the DrainPoints table in

the GRAIP database.

a) SBI: Stream blocking Index indicating plugging susceptibility based

upon ratio of pipe diameters to channel width and skew angle.

b) PipeDiaToChannelWidth: Ratio for pipe diameter divided by channel

width ratio class.
c) SkewAngle: skew angle.

Habitat Segmentation Analysis

1) Fish Passage Barrier: Use Habitat Segmentation Analysis -> Fish Passage Barrier

function in the GRAIP GIS Toolbar to open the tool dialog (Figure 28).

. Fish Passage Barriers

Input
Default Parameters for Fish Paszage Barrier Calculations
Crozzing Slope Sp (%) Outlet Drop ODp [ft)
2 0.8

Fipe/Channel *idth ratio w*p  Outlet Drop to Pool Depth ratio
|n.?5 |1 125

Drain Pointz Shapefiles

|D:"u:|emn:|"-.D rainPaints. shp

Output
11 The field B arrier iz appended to the table of the Drain Paointz Shapefile using criteria for crozzings that
represent fizh pazzage bariers flag stream crossings that are barmriers.

Cancel

Figure 28: Fish Passage barrier function.

Click compute to find the fish passage barriers and assign identifier representing the

status of the stream crossing. 0- Clear passage, 1- Partial passage and 2- Blocked.
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2) Fish Habitat Segmentation: Use Habitat Segmentation Analysis -> Fish Habitat
Segmentation function to open the tool dialog for demarcating habitat clusters.

Figure 29 shows the dialog for fish habitat segmentation determination.

. Habitat Segmentation

Input
TauDEM Stream Metwork, Shapefile

|D:'\DEMD'\DEM‘\demnet.shp J
Screened Stream Croszing Shapefile Used az Qutlets in TaulDEM Hetwark Delineation

|Di:\demoMatchSi, shp
FSak Drain Points Shapefile

|D:'\|:|em|:|"-.D rainiPoints. shp J

I Congider partially blocked as barrier.

Output
1] Each stream segment iz aszigned a unique identifier for each contiguous habitat cluster as demarcated by

fish paszage barriers. This attribute will be appended ta the stream line feature clazs.

LCancel

Figure 29: Habitat Segmentation Function Dialog.

Click Compute to assign each stream segment a unique identifier indicating which

habitat cluster it belongs to. The habitat cluster identifier is appended to the TauDEM

stream network shapefiles attribute table.
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Table 1: USFS land type classes used to determine BOISED parameters obtained from
USFS Rocky Mountain Research station, Boise, ID.

Landtype | GEF | Side Slope SDR Disturbed
gradient Width
ABCD 0.80 |5 0.000326 4.06
101 0.80 |5 0.000326 4.06
1012 0.80 |5 0.000326 4.06
1013 0.80 |5 0.000163 4.06
101A 0.80 |5 0.000163 4.06
102 0.80 |5 0.000163 4.06
103 0.80 |10 0.000456 4.24
1031 0.80 |5 8.14E-05 4.06
104 0.80 |15 0.002568 4.54
1042 0.80 |10 0.000761 4.24
105 0.80 |15 0.002568 4.54
1054 0.80 |20 0.017392 4.96
1055 0.80 |15 0.007337 4.54
106 090 |10 0.000364 4.24
1062 090 |25 0.007119 55
106B 090 |20 0.003645 4.96
107 1.00 | 40 0.048697 7.84
1071 1.00 | 20 0.008696 4.96
1072 1.00 |25 0.016984 5.5
108 0.80 |45 0.033215 8.86
109 090 |35 0.019535 6.94
1092 090 |35 0.027907 6.94
1095 090 |35 0.027907 6.94
1099 0.90 |30 0.012302 6.16
109A 090 |35 0.055814 6.94
109A1 090 |50 0.081361 10
109B 0.90 |40 0.029131 7.84
109B1 0.90 |40 0.029131 7.84
109C 090 |45 0.031108 8.86
109D1 0.90 |60 0.147769 12.64
109D2 090 |20 0.003193 4.96
109E 090 |45 0.06234 8.86
109G 0.90 |50 0.051206 10
109Gl 090 |60 0.073737 12.64
109N1 0.90 |40 0.02554 7.84




110 0.80 |15 0.002568 4.54
110X 0.80 |20 0.006087 4.96
111A 0.80 |55 0.075804 11.26
111A1 0.80 |55 0.108291 11.26
111A2 0.80 |45 0.059312 8.86
111A3 0.80 |40 0.02916 7.84
111B 0.80 |55 0.075728 11.26
111BI1 0.80 |55 0.075728 11.26
111B2 0.80 |50 0.056896 10
111C 0.80 |55 0.056796 11.26
111C3 0.80 |45 0.031108 8.86
111D 0.80 |70 0.046837 15.76
111D2 0.80 | 60 0.036868 12.64
111D3 0.80 |45 0.012443 8.86
111G 0.80 |55 0.090874 11.26
111X 0.80 |75 0.144017 17.5
111X1 0.80 |50 0.042672 10
112 0.80 |55 0.151759 11.26
1121 0.80 |35 0.046604 6.94
113 0.80 |75 0.115329 17.5
1131 0.80 |55 0.037902 11.26
114 0.80 |45 0.029656 8.86
1142 0.80 |40 0.020828 7.84
115 0.80 |55 0.060643 11.26
120A 1.00 | 50 0.068343 10
120A1 1.00 |45 0.049822 8.86
120A2 1.00 |45 0.041518 8.86
120A8 1.00 | 50 0.195266 10
120B 1.10 |55 0.063612 11.26
120B1 1.20 |45 0.049772 8.86
120B2 1.10 |50 0.047792 10
120B3 1.10 | 55 0.181748 11.26
120B4 1.10 | 45 0.034841 8.86
120B5 0.60 |50 0.056896 10
120B6 1.10 | 40 0.02447 7.84
120B10 | 0.42 |45 0.049772 8.86
120B13 | 1.10 | 50 0.039827 10
120B14 | 042 | 60 0.098316 12.64
120C 1.10 | 55 0.047709 11.26
120C1 1.10 | 60 0.061939 12.64
120C2 1.10 | 55 0.136311 11.26
120C3 1.10 | 65 0.1125 14.14
120C8 1.10 | 60 0.176969 12.64
120C11 | 1.10 | 50 0.035844 10
120C12 | 1.10 | 50 0.035844 10
120D 1.10 |70 0.14051 15.76
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120D2 1.10 |75 0.120975 17.5
120D3 1.10 | 65 0.1125 14.14
120D4 1.10 | 65 0.225 14.14
120E 1.20 | 30 0.014366 6.16
120E1 1.20 |45 0.029034 8.86
120E2 1.20 | 40 0.029131 7.84
120E3 1.20 | 40 0.020391 7.84
120E4 1.20 | 30 0.024579 6.16
120E5 1.20 | 40 0.069914 7.84
120E6 1.20 | 40 0.058261 7.84
121 1.20 | 30 0.014366 6.16
121E 1.20 | 35 0.022813 6.94
121E1 1.20 |20 0.004257 4.96
122 1.10 |75 0.460856 17.5
1221 1.10 | 75 0.172821 17.5
1222 1.10 | 75 0.120975 17.5
1224 1.10 |75 0.120975 17.5
1225 1.10 | 80 0.146818 19.36
1228 1.10 | 70 0.374693 15.76
123 1.10 | 40 0.02447 7.84
1231 1.10 | 15 0.001845 4.54
1232 1.10 |55 0.075728 11.26
1233 1.10 | 40 0.02916 7.84
123B 1.10 |25 0.008314 5.5
123B1 1.10 | 40 0.029131 7.84
123C 1.10 | 55 0.047709 11.26
125 0.30 |50 0.045562 10
1312 042 |40 0.020391 7.84
1313 042 |40 0.058261 7.84
133A3 042 |55 0.108291 11.26
133B 042 |55 0.075728 11.26
133C1 042 |55 0.056796 11.26
1343 042 |40 0.023328 7.84
1351 042 |70 0.133953 15.76
1352 042 |40 0.049988 7.84
1353 042 |45 0.033215 8.86
1361 042 |10 0.000781 4.24
1362 042 |15 0.002636 4.54
1363 042 |15 0.001845 4.54
1365 042 |45 0.041518 8.86
1366 042 |25 0.008492 5.5
1367 042 |5 4.07E-05 4.06
1368 042 |35 0.055814 6.94
140B2 0.75 |45 0.049772 8.86
140B3 0.75 |55 0.181748 11.26
140C1 0.75 |50 0.035844 10
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140C2 0.75 |55 0.068155 11.26
140C3 0.75 |60 0.176969 12.64
140E1 0.75 |40 0.029131 7.84
140E2 0.75 |50 0.039827 10
141 0.75 |45 0.048487 8.86
143 0.75 |50 0.068343 10
143C 0.75 |55 0.068155 11.26
DO11 1.00 | 10 0.004686 4.24
DO111 1.00 | 10 0.002609 4.24
D0112 1.00 | 25 0.016984 5.5
D013 1.00 |5 0.000163 4.06
D021 1.00 |15 0.001834 4.54
D031 1.00 |5 0.000163 4.06
D032 1.00 |5 0.000163 4.06
D081 1.00 |10 0.002609 4.24
D082 1.00 |35 0.200929 6.94
DI010 1.00 | 15 0.003669 4.54
D102 1.00 | 50 0.108698 10
D131 1.00 |5 0.000163 4.06
G061 1.00 |15 0.002568 4.54
G062 1.00 | 25 0.011889 5.5
G131 1.00 |15 0.003082 4.54
Glel 1.00 | 15 0.002054 4.54
G162 1.00 |35 0.046883 6.94
S052 1.00 | 50 0.135873 10
S081 1.00 |45 0.087102 8.86
S091 1.00 | 60 0.154848 12.64
S0911 1.00 | 60 0.154848 12.64
S0912 1.00 | 70 0.421529 15.76
S0914 1.00 | 55 0.088526 11.26
S092 1.00 | 70 0.295071 15.76
S093 1.00 | 55 0.143126 11.26
S181 1.00 | 20 0.007811 4.96
S1811 1.00 | 60 0.253065 12.64
S1812 1.00 | 70 0.393427 15.76
S182 1.00 | 70 0.393427 15.76
S201 1.00 | 50 0.089611 10
S211 1.00 | 55 0.170389 11.26
S2810 1.00 | 50 0.170687 10
S301 1.00 | 40 0.045881 7.84
S3012 1.00 |45 0.065326 8.86
VON 042 |10 0.003905 4.24
V111 042 |10 0.004686 4.24
CZ1 042 |15 0.002197 4.54
Cz2 1.00 | 60 0.073737 12.64
CZ3 1.00 |55 0.056796 11.26
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Cz4 0.70 |55 0.075728 11.26
CZ5 1.00 | 55 0.039757 11.26
CZ6 1.00 |55 0.075728 11.26
Cz7 1.00 | 65 0.09375 14.14
CZ8 1.00 |35 0.014636 6.94
CZ9 0.70 |45 0.041477 8.86
CZ10 1.00 | 60 0.073737 12.64
CZl11 1.00 | 60 0.073737 12.64
Cz12 1.00 | 50 0.042672 10
CZ13 042 |45 0.059312 8.86
CZ14 1.00 |55 0.075728 11.26
CZ15 0.70 |50 0.056896 10
CZ16 0.70 |45 0.041477 8.86
Cz17 0.70 |15 0.001536 4.54
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